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Getting Started 

Barnes & Noble is pleased to offer Print Books on Demand (PBOD), a printing service that allows 

authors and independent presses to get printed copies of their books at the push of a button. PBOD is 

an ideal solution for those who want a single copy or small quantities of their book printed on demand.  

To get the most out of Barnes & Noble PBOD technology, your manuscript needs to be formatted as a 

print-ready file. This guide offers formatting instructions and recommendations that will help you make 

your manuscript print-ready, so your printed book turns out just the way you want it to. This guide 

presents instructions for formatting your book in Microsoft Word. For instructions using Pages for Mac 

or Pages for iOS, see the appendix at the end of the guide. 

We also offer Professional Publishing Services packages for purchase. These packages are designed to 

guide you through the publishing process and help ensure your manuscript turns into a beautiful, quality-

printed book.  

Visit www.bn.com/PrintOnDemand to learn more, or visit your local Barnes & Noble store for more 

information. 

 

http://www.bn.com/PrintOnDemand
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Book File Requirements 

To print a book with Barnes & Noble, you will need to have print-ready files for both the book interior 

and the cover. A PBOD print-ready file is a PDF (Portable Document Format) file with certain 

formatting rules applied during creation.  

This formatting guide will provide tips on how to make sure your book and cover files are ready for our 

printers. 

What is a Print-Ready PDF? 

Whether you’re a major book publisher or an independent author, the printing process starts the same 

way—with a print-ready PDF. 

Please note that just because a file has a .PDF extension that does not mean it is necessarily 

“print-ready.”   

Most authors write their books in a word processing software program, such as Microsoft Word, 

WordPerfect, Mac Pages, or Google Docs. These programs are perfect for the writing process, but not 

ideal for printing because what is shown on screen may not translate faithfully to the printer. Spacing 

and page breaks may differ, for example. A document that looks tidy online might appear awkward when 

printed. 

The good news is that a PDF file will translate exactly what’s on screen to the printer. No matter the 

computer or machine, a PDF will print the same way because it’s in a “locked format.” Having a locked-

formatted document is great for knowing exactly how your book will look when it’s printed.  

A print-ready PDF does have limitations, though. There are a few rules to make sure the PDF version of 

your manuscript results in a good-looking book. We’ll walk you through the steps for converting from a 

word document to a PDF, and help you avoid the pitfalls of these limitations. 

 

For the more adventurous, there are design layout programs like InDesign from Adobe that 

provide more advanced features and finer controls for page design. It is also possible to create 

PDFs from these programs. For more information about converting InDesign files into PDFs, 

please visit http://helpx.adobe.com/indesign.html. 

http://helpx.adobe.com/indesign.html
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Pre-Press Manuscript  

Preparing your text document is an important step in getting your manuscript ready for print. To help 

you create a print-ready PDF, we’ll cover some basic book structure and design elements that you need 

to address in your word processing file before you create your print-ready PDF. 

Barnes & Noble offers some easy-to-use templates available for your convenience. You can simplify your 

pre-press work by flowing your text into these templates. See the Templates section on page 24 for 

more information.  

Proofread and Spell-Check  

Read over your manuscript from start to finish, keeping an eye out for grammatical or other errors that 

might have crept in while writing. Use your word processing’s spell-check feature to check for 

typographical errors or misspellings. It’s often helpful to have a trusted friend or colleague read your 

work with a fresh eye. 

Spacing and Text Placement 

In general, it’s best to use paragraph styles to control the spacing before and after paragraphs and the 

insertion of page breaks in a text. 

Using Hard Returns 

Use “hard returns” or the Enter key for paragraph breaks only. DO NOT use a series of hard returns 

to indicate a new page. Using hard returns to indicate a page break will result in a messy book page 

when printing. Instead, use the page break or section break option in your word processor for this type 

of break.  

 

Keeping Text Reflowlable 

Most word processors, including Word, are reflowable, meaning they automatically flow words from 

line to line, making adjustments automatically when the user changes the window size. For PBOD, be 

sure to keep text reflowable; in most word processors, this is automatic. Plus, if your document’s 

paragraph styles are set to full justified (flowing the text of complete lines from the left margin to the 

right, as this paragraph does), hyphenation will be automatic. This will allow you to freely enter and edit 

text without manually breaking a word at the end of a line of text.  

 

Using the Space Bar 

As a general rule, do not use the space bar to indent paragraphs or adjust the indentation or placement 

of other text elements. Use paragraph styles to automatically indent paragraphs, or use the Tab key. Do 

not use multiple spaces to indent paragraphs because it will not translate properly to a printed page. 

Also, if you want to center text, use the text-centering tool. Do not use the space bar to move lines 

visually across the page. These improperly used spaces will cause inconsistencies in layout when going 

through your final formatting process. 
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Book Layout and Elements 

As you prepare your book, it’s helpful to keep in mind the following conventions used in book 

publishing. 

Book Pages and Page Spreads 

We count two book pages (e.g., page 1 and page 2) on a single sheet of paper. When we talk about a 

page in a book, we mean only one side of the paper. Each sheet of paper holds two pages: the front and 

the back. If there are 200 pages in a book, there are only 100 sheets of paper. 

A spread is a book layout with two facing pages. 

Odd-number pages appear on the right side of a spread. Even number pages appear on the left. Page 1 

always begins on the right side, and establishes the pattern of odd/even used for the rest of the book. 

 

 

The Book Block 

In publishing, the collection of all the pages between the covers is known as the “book block.” Within 

the book block itself, there are usually three sets of pages: 

 The Front Matter 

The front matter includes the title page, the copyright page, a table of contents, and perhaps other 

elements, such as a foreword, a preface, and an epigraph.  
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 The Core Matter 

The core matter consists of the main content of a book:  the narrative in a novel, the poems in a 

poetry collection, the essays in an essay collection, and so on. 

 The Back Matter 

The back matter consists of all the content that follows the core matter. This could include an 

epilogue, an afterword, acknowledgements, a short profile of the author, and an index. 

Front Matter 

Front matter is the material in the front of the book, before the book narrative begins. Front matter is 

up to your personal preference, though it’s good to at least have a title page before the first narrative 

page. Except for the Table of Contents, these elements are typically one page each. In typical order of 

appearance: 

 Title page  

 Copyright page 

 Dedication page 

 Table of contents 

 Epigraph  

 Preface 

 Foreword 

Each of these elements is described below. 

Title Page 

The title page appears on the right and presents the full title of the book and the author’s name.  

Copyright Page 

A copyright notice usually appears on back of the title page. Here’s a typical copyright notice: 

Copyright © Sarah Doe. All rights reserved. 

Under U.S. copyright law, your self-published work is protected as soon as you put pen to 

paper. Copyright is based on your creative authorship and is not dependent on any formal 

agreement with a book publisher or self-publishing company, although registration with the U.S. 

Copyright Office is beneficial.  

Copyright Registration allows you a higher level of security and confidence when it comes to 

protecting your work. When you register your work with the U.S. Copyright office, you create a 

public record of your authorship. Even though you are protected the moment you start writing, 

you’ll have to register your work with the Copyright Office to be officially recognized as the 

copyright holder in a court of law. The use of the copyright notice is the responsibility of the 

copyright owner.  For more information, see http://www.copyright.gov/circs/circ01.pdf 
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You do not need an ISBN to print your book using Barnes & Noble PBOD. However, if your book does 

have an ISBN, you should list it. 

Dedication 

If an author wants to dedicate the book to a person or group of people, that dedication usually appears 

on its own odd-numbered page. The dedication itself is often centered and set in italic like so: 

To Mary, as always 

Table of Contents 

The table of contents follows next. Microsoft Word and other word processors include tools for 

automatically generating a table of contents to ensure it accurately reflects your latest changes to the 

document. 

Epigraph 

An epigraph is a quotation or group of quotations that the author feels set the tone for the book that 

follows. Like dedications, epigraphs might be centered on the page and set in italics. Quotations should 

always be attributed. 

Optimism is the faith that leads to achievement. 

                     --Helen Keller 

Preface 

A preface is an introduction written by the author of the book. 

Foreword 

A forward is an introduction usually written by someone other than the author of the book. In non-

fiction, the foreword might be written by another expert in the same field as the author. 

 

The Core Matter 

Chapter Breaks 

Many books contain chapter breaks, but it’s not a requirement. If your manuscript does have chapter 

breaks, think about how they visually appear on the page.  

Usually chapter titles appear about a third of the way down the page. In your word processor, you 

might want to use a consistent Chapter Title paragraph style that specifies a set number of inches or 

points to make the title appear at a specific place on the page. Use paragraph styles rather than a series 

of hard returns to position titles and create blank space on a page. 
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The picture below shows how chapter breaks and chapter titles are typically formatted. 

 

Setting Up Chapter Breaks and Chapter Titles using Microsoft Word 

 Starting on a New Page, click the Page Layout tab and then click Breaks. Click the type of 

section break that you want to use. You can also choose to have your chapters start on a new 

right page by choosing Section Break: Odd Page.  
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 Chapter “Sink” – The chapter text starts down in the middle or lower third of the page. This is 

usually done if the chapter starts on a right hand (or odd) page. A good way to create a Chapter 

Sink is to define a Chapter Title paragraph style that specifies the amount of spacing you want to 

appear before the title and use that consistently throughout your book. Use this approach 

rather than pressing return multiple times to create the sink. 

Back Matter 

Back matter is the material in the back of the book, after the last page of the narrative text. Like front 

matter, not all books have or require back matter. 

In typical order of appearance, back matter can include the following: 

 Epilogue  

 Afterword  

 Endnotes  

 Bibliography 

 Glossary 

 Index 

 Author biography 

Epilogue 

An epilogue is a brief continuation of the main narrative or content of the book. 

Afterword 

An afterword is commentary on the book, usually written by someone other than the book’s author. An 

afterword might describe the historical context in which the book was written or provide some other 

kind of useful background material. 

Endnotes 

If the book included numbered reference notes that were not formatted as footnotes, they can appear 

in an endnotes section at the back of the book. 

Bibliography 

In nonfiction books, the bibliography lists all the sources that the author or authors consulted for their 

work. 

Glossary 

A glossary defines special or unusual terms in a book. 

Index 

An index is an alphabetical list of important topics from the book, along with citations of all the pages on 

which those topics appear. 

Author Biography 

A brief “About the Author” section might offer a brief biography of the author. 
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Layout and Design 

This section provides tips for laying out a Microsoft Word document to make an aesthetically pleasing 

and professional looking book. 

To help simplify the layout and design process, we have created a set of layout templates for 

Microsoft Word that you can download at www.bn.com/PrintOnDemand. These templates offer 

an easy way to format your book based on the desired trim size of your book as well as offer 

page design suggestions. See the Templates section below for more information. 

Planning the way a manuscript appears on the fixed book page is called “formatting,” or layout and 

design. Well-thought-out design elements make your book aesthetically pleasing and easier for the 

reader to follow.   

For a quality, finished product, pay close attention to the consistency of your design. If you have 

a chapter heading style, use that style for each chapter header throughout the book. If you start 

your chapter halfway down the page, start all the chapters halfway down the page. Once you 

have finished designing the look of your book, make sure you go back and review the whole 

book for consistency in your design elements. 

 

Paperback Format 

Barnes & Noble PBOD uses a standard paperback form with a glued spine binding. This type of binding 

is sometimes called perfect binding, creating a perfect-bound book. 

To print a paperback book, you will need to submit a separate print-ready file for the paperback cover.  

For information about setting up a cover, see page 32. 

Page Count and Trim Size 

It’s important to consider the physical dimensions of your book when formatting your document. The 

height and width of a book is called its “trim size.”  Page count and trim size are closely related because 

the physical dimensions of the trim size affect the page size and therefore how many words will fit on a 

page (i.e., the smaller the page, the longer the page count).  

Page Count 

The machines we use to print books have minimum and maximum page counts:  

 Minimum Page Count for white and cream colored paper: 40 pages 

 Maximum Page Count for white and cream colored paper: 800 pages 

 Minimum Page Count for photo book paper: 16 pages 

 Maximum Page Count for photo book paper: 650 pages 

file:///C:/Users/sdickman/Documents/POD/Formatting%20Guide/www.bn.com/PrintOnDemand
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NOTE: The page count includes all the pages of your interior text, regardless of which page actually is 

marked page 1.   

Additionally, there are maximum trim sizes depending on the page count/length of your book. For 

example, if your book is 350 pages it cannot be an 8.5” by 8.5” trim size.  

 

 40-300 pages max trim: 8” x 10.5” 

 301-400 pages max trim: 7.875” x 10.5” 

 401-500 pages max trim: 7.75” x 10.5” 

 501-600 pages max trim: 7.6” x 10.5” 

 601-700 pages max trim: 7.5” x 10.5” 

 701-800 pages max trim: 7.5” x 10.5” 

 

Trim Sizes 

The most popular trim sizes for fiction and narrative non-fiction are shown below: 

 

Depending on the type of book you are printing, there are other trim size options available. The trim 

sizes below are optimal for photo books, cookbooks, and children’s books. 

 



16 Barnes & Noble Print Books on Demand Formatting Guide 

Formatting for Trim Size 

Once you’ve decided on your desired trim size, you need to designate those measurements in your 

document. Setting the document/paper size will tell the printer how big to make your book page so it 

fits with your desired trim size. It’s very important to set these measurements.  

How to Set Paper Size using Word on a PC  

Click the Page Layout tab and then click on the lower right button of the Page Setup section to open the 

complete dialog box: 

 

 

Click the Paper tab, select the custom size option and enter your desired measurements. Click OK to 

apply this size to the whole document. 

 

 

How to Set Paper Size using Word on a Mac  

Choose Page Setup…under File from the top navigation bar. Under Paper Size choose Manage Custom 

Sizes…and then type in your specific trim size dimensions.  
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Margin Size  

Margin settings in your book establish the white space that appears around the text. After you’ve set 

your document/paper size, you will need to set the margin size. You want to have enough white space 

so that the text doesn’t run off the book page. The standard margin setting is 0.5” on each side of the 

text.  

Margin settings are set from the edge of the paper size you indicated so it’s important to set the 

document/paper size first. 

Setting Margin Size using Word on a PC  

Click the Page Layout tab and then click on the lower right button of the Page Setup section to open the 

complete dialog box. Click the Margins tab and enter your desired margin measurements. Choose your 

orientation and then select Mirror Margins in the “Pages” section. Click OK to apply these settings to 

the document.  
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Setting Margin Size using Word on a Mac 

Click on Layout from the navigation bar, then click on Margins. Choose Custom Margins...to set your 

margins, gutter and mirror margins all in one place.  

 

Gutter 

When a book page gets bound, the inner edges of the book pages are glued together. These inner 

margins are often called the “gutter,” and it’s important to leave enough room on the inside margin so 

that text doesn’t fall into the gutter. The longer the book, the thicker the book, and therefore, the 

bigger the inside margins should be.   

 As long as you set the margins to 0.5,” then you DO NOT need to set an additional gutter. Set 

gutter to 0.0.˝ 

 “Mirror margins” is usually the best format option.  

Images 

If you’re including images in your document, it’s important to that they be high-resolution images, so 

that they print crisp and clear. We recommend saving images at 300 dpi (dots per inch) or higher. 

Note that the color on your computer screen will not necessarily match the color of your printed 

pages. Your computer screen shows projected RGB color (Red, Green and Blue), and the printed books 

show CMYK color (Cyan, Magenta, Yellow and Black). You can print a book that includes RGB images, 

but it’s traditional to use CMYK images, since those are the colors used by traditional printing presses. 

Before printing a large numbers of copies, be sure to look over your print-ready PDF to ensure that the 

images appear how you want them, or print out one copy of your book to start. 
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A Checklist for Images 

Here is a checklist to make sure your images meet print-ready requirements: 

 Images must be at least 300 DPI to be considered print quality.  

 If you are printing in black and white, images should be saved in grayscale. 

 For full-bleed images (images that print to the edge of the page), a good bleed value is 0.125.” 

The bleed value is the margin beyond the edge of the page to which the image should extend in 

order to ensure that printing consistently reaches the edge of the page. 

 Images should be sized at 100%. 

 Images should be flattened to analog. Analog means that an image with multiple layers—designed 

using Photoshop, InDesign or Illustrator—has been condensed into a single layer. For 

instructions on flattening images, see below.  

 Images must be embedded into the document and not be a reference link. The PDF should 

include everything needed to print the file—images, fonts, and text. 

 Remember that you must have the rights to all of the images you use. 

Converting a Multi-layer Image to Analog 

To retain the richness and depth of a multi-layer image that you need to save as a flattened, analog 

version for your print-ready PDF, you’ll need to save the image as a .psd or .png file. On a PC, you can 

also click CTRL+A to select the entire image, press CTRL+SHIFT+C to copy the selection as a single 

layer, and then press CTRL+V to paste the selection back into your workspace. That will give you the 

flattened layer you want, with the original layers still intact underneath. 

Additional Help 

For instructions on how to insert clip art or an image from a computer file, or how to change an image’s 

position on the page, please refer to the information from this link for: 

Microsoft Office 2007:  

http://office.microsoft.com/en-us/word-help/insert-a-picture-or-clip-art-HA010097036.aspx?CTT=1 

Microsoft Office 2010:  

http://office.microsoft.com/en-us/word-help/learn-more-about-smartart-graphics-

HA010354757.aspx?CTT=5&origin=HA010097036 

 

 

 

http://office.microsoft.com/en-us/word-help/insert-a-picture-or-clip-art-HA010097036.aspx?CTT=1
http://office.microsoft.com/en-us/word-help/learn-more-about-smartart-graphics-HA010354757.aspx?CTT=5&origin=HA010097036
http://office.microsoft.com/en-us/word-help/learn-more-about-smartart-graphics-HA010354757.aspx?CTT=5&origin=HA010097036
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Typeface/Fonts 

Choosing the right typeface/font for your book is based on personal preference. However, certain fonts 

are better for reading and certain fonts are better for design. Whichever font you choose, it’s important 

to think about how the reader will consume it. 

When talking about fonts, you will often hear the terms “serif” and “sans serif.” A serif 

typeface has little lines at the terminus of each stroke. A sans serif typeface does not. Typically, 

serif fonts are considered more readable and are good for the body text of your book. If you 

want to use sans serif fonts, they typically are better for chapter or section headers. 

 

Typefaces 

Here are examples of popular serif typefaces, all set in eleven points. (Point sizes are explained below.) 

 Garamond 

The quick brown fox jumped over the lazy dog. 

 Palatino 

The quick brown fox jumped over the lazy dog. 

 Times New Roman 

The quick brown fox jumped over the lazy dog. 

 Century 

The quick brown fox jumped over the lazy dog. 

Here are examples of popular sans serif typefaces, also set in eleven points. 

 Arial 

The quick brown fox jumped over the lazy dog. 

 Helvetica 

The quick brown fox jumped over the lazy dog. 

 Verdana 

The quick brown fox jumped over the lazy dog. 

Font Size 

The size of type is important for making sure your book is easy to read. Type is measured in points. 

Generally, keeping your font between 11 and 12 points for the body will result in an easily legible book. 

Feel free to experiment with large type sizes for chapter or section headings. 

Line Spacing 

Typically, line spacing is set between “single-spacing” and “1.5 lines” to make text legible without leaving 

too much white space between lines. 
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You can also specify line spacing in points. Generally, it’s best to have line spacing for the main text be at 

least 2 points larger than the font size. For example, if you’re using 12 point type, try setting the line 

spacing or line height to 14, 14.5, or 15 points. 

Pagination 

Pagination means numbering the pages in your book. To help your readers find their place in your book, 

we recommend using pagination.  

Page numbers typically appear in the lower left corner of even-numbered pages and the lower right 

corner of odd-numbered pages, but you can place them elsewhere if you’d like. Explore the Pagination 

tool in your word processor to discover which options are available to you. 

Some publishers use lowercase Roman numerals to number pages in the front matter and then switch 

to traditional Arabic numerals for the main narrative.  

If your book includes front matter, you have the choice of numbering the first page of your narrative 

page 1 or you can do as some publishers do and assign the first page of narrative the number it would 

have if you were numbering all pages, including the front matter, sequentially. Thus, front matter might 

run from page iii to page xxi, and the main narrative might start on page 23. 

The picture below shows how front matter such as a preface might be assigned page numbering in 

lowercase roman type. The main narrative begins with the next sequential number but set in Arabic 

numerals. You might want to look at how publishers you admire have assigned page numbers in their 

books to get an idea of how you want to assign page numbers in yours. 
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Other Layout Elements to Consider 

It’s easy to spend a lot of time trying to perfect your layout. Here are just a few more elements to 

consider as you work on your final design. 

Running Headers/Running Footers 

Running heads/running feet are the elements at the top or bottom of book pages. Typically, this can 

include things like the author’s last name, the book title, the title of the chapter, etc.  A common 

running head is the page number. 

Applying Running Heads/Footers using Word on a PC 

Open the Page Setup dialog box. Click the Layout tab and you will be able to adjust the layout, section 

start, alignment, and set values for headers and footers. 

 Choose how you want a new section to start — Continuous, New Page, Odd Page or Even 

Page. 

 Choose to set different text on odd and even pages, or a different first page. Then set the values 

for the header and footer. 

 Choose the vertical alignment for the section (this is usually set to Top). 

Select if you want to use these settings for “This section” or “The whole document” and then 

click OK to apply. 
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Applying Running Heads/Footers using Word on a Mac 

You can set the headers and footers of your book from the Document Elements section at the top of 

your toolbar.  

 

 

Widows and Orphans 

In typesetting, a widow is the last line of a paragraph when it appears by itself at the top of a page. The 

image below shows an example of a widow. 

 

An orphan is either the first line of a paragraph appearing by itself at the bottom of the page, or a word 

or two appearing as the last line of a paragraph or as a line at the top of a page. The image below shows 

an example of an orphan. 
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Traditionally, typesetters would try to avoid widows and orphans, because the white space around them 

can look awkward. 

Microsoft Word features an on/off control for limiting widows and orphans but you don’t have to worry 

about them if you don’t want to. 

Full Justification/Rag Right 

Paragraph alignment is up to your personal preference. Books are often designed so that the left and 

right paragraph lines are flush to the margin or fully justified.  

When the right side of the text lines are allowed to appear jagged, this is called “ragged right” or “rag 

right.” 

Fiction and non-fiction are usually typeset fully justified, but much poetry is typeset ragged right. 

Crop Marks  

Crop marks are patterns of lines indicating where to trim (crop) the paper to a smaller document size. 

Your file does not need crop marks for Barnes & Noble PBOD, so please remove any crop marks 

before submitting your file for printing. 

Templates 

To make your book formatting process a little easier, we offer templates for Microsoft Word in the 

various trim sizes available for PBOD. There are templates for both book interiors and book covers.  

Our templates are available on the www.bn.com/PrintOnDemand.   

How to Use the Barnes & Noble PBOD Interior Templates 

There are two types of interior templates for use with Microsoft Word: formatted with and formatted 

without sample text. Formatted with sample text ensures that the page size, layout, orientation, margins, 

gutter and paragraph styles are set. You are free to provide your own front matter, chapter heading 

style, and other options that are based on personal preference.  

Formatted without sample text offers layout, design, and formatting suggestions that you can use as a 

model for creating your own book.  

How to Use the Interior Sample with Text 

These samples give you a greater idea of what the book will look like using these formats. Before you 

proceed, you should have enabled Show Paragraph Marks – this option makes it easier to highlight the 

text accurately. 

With both your source document and one of the templates open, go to your source document and 

highlight and copy the text you wish to paste into the template. Then navigate to the template and 

carefully highlight the text you wish to replace. Paste the text – it should now be in the template style. If 

this is not the case, then look for the Paste Options icon at the end of the text and choose Match 

Destination Formatting (whether you use a Mac or a PC this function works similarly).  

file:///C:/Users/sdickman/Documents/POD/Formatting%20Guide/www.bn.com/PrintOnDemand
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You can delete anything you do not need, or add more pages and chapters and apply the styles as 

necessary. 

How to Use the Interior Sample without Text 

This is the easiest way to proceed – just navigate to the section of existing text and start typing. You can 

delete anything you do not need, or add more pages and chapters and apply the styles as necessary. 

How to Use the Barnes & Noble PBOD Cover Templates 

There are two types of cover templates for use with Microsoft Word and Adobe InDesign. Both 

templates show visible front and back covers formatted to the correct trim size, with an example of the 

spine. The spine will vary depending on the number of interior pages. All templates are laid out centered 

on an 11” x 17” background indicating a 0.125” bleed. 

To use these templates, simply replace the placeholder image boxes with your own artwork. 
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Generating a Print-Ready PDF 

Now that your manuscript is formatted properly, you have to save it as a PDF so that it will print 

exactly as you have laid it out. But first, make sure to save your final manuscript as a word processing 

file too just in case you need to edit something later.  

If you have installed a free PDF conversion tool like Adobe Acrobat on your computer, saving a Word 

document as a print-ready PDF is fairly straightforward, but there are some important steps you’ll need 

to take to create a type of PDF that’s compatible for the book printer. These steps include: 

 Ensuring that the file is not encrypted and includes no encrypted PDF. 

 Embedding fonts in the PDF 

If you do not have Adobe Acrobat or another PDF conversion program installed on your 

computer, you can use an online PDF-conversion service available at www.adobe.com/createpdf. 

Removing Encryption 

Make sure there is no encryption on any aspect of the file, including the images. Encryption generally 

means password protection, so just be sure that none of your files are password-protected.  

If you have encrypted a file i.e., made it password-protected on your computer, you can remove file 

encryption by changing the file's properties.  

Removing encryption from a file on a PC 

Find the file from which you want to remove encryption. Right-click on the file, then click the Properties 

link in the context-menu to open a Properties window. Click the Advanced button in the attributes 

section of the Properties window. This opens the Advanced Attributes window. Click to uncheck the 

box next to Encrypt contents to secure data in the Advanced Attributes window. Click the OK button 

to close the Advanced Attributes window. Click the Apply button in the Properties window, then click 

the OK button. This closes the window and completes the encryption removal process. 

Removing encryption from a file on a Mac 

Right click on the file by hitting Control + Click. Choose Get Info from the list that opens. Make sure 

the locked box is unchecked to ensure there is no password protection on your file.  

Embedding Fonts 

The PDF document needs to contain certain information so the printer knows how to render your 

book’s typeface. In some word processing software you need to specifically indicate that you want to 

embed your fonts in the document so that they render properly in the PDF version of your file. 

Thankfully, most word processing software makes this easy to do.  
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Word for Mac does not have a font embedding option. You should be able to save to PDF without 

formatting issues, provided your PDF software is set to the correct trim (we’ll go over that later).  

Embedding Fonts using Word on a PC 

From within a Word document, click the Office button in the top left corner of the screen. At the 

bottom of the dialog box that opens, click the Word Options button. Or, click File and then click 

Options. 

  or    

Inside the Options section you will see the dialog box below. In the last section on the screen select 

‘Embed fonts in the file’ by checking the box. Leave the other two boxes unchecked. Click OK. The file 

will now save with fonts embedded. 
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Saving a File as a PDF  

Note:  When using Microsoft Word, there are a number of methods for creating a PDF file. 

Generally speaking, they will produce the same result, but following the steps below will ensure 

your PDF is print-ready for PBOD. 

File  Save As 

 

Using Word on a PC 

On the top navigation bar choose File  Save As and you will see this dialog box. Choose save as type:  

PDF. Open the PDF and check each page to make sure it looks like you expected it to.  
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Using Word on a Mac  

From the top navigation bar choose File, then Save As. Under Format choose PDF.  

 

You can rename your file in the Save As box. Open the PDF and check each page to make sure it looks 

like you expected it to.  

 

Setting PDF Dimensions 

Setting PDF dimensions works the same on Microsoft Word whether you’re using a PC or a Mac. On 

the top navigation bar click File  Print to open the Print dialogue box. 
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Click on Page Setup. 

 

 

Click on Paper Size. 

 

Select the Paper Size for the PDF you are creating. 
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Pre-Publication Checklist 

Use this checklist to make sure that your PDF is ready for publication. 

 Text has been spellchecked and proofread. 

 Text formatting is complete. 

o Spacing is controlled by paragraph styles and page breaks, not by spaces, tabs, or hard 

returns. 

o Margins are set to 0.5" or a similar distance. 

o No crop marks appear. 

 Images are ready. 

o You own all the rights to the images in the book. 

o All images are 300 dpi or higher. 

o All images have been saved in an analog mode. 

o Black and white images have been saved as grayscale. 

o No images are encrypted. 

 Pagination is ready. 

o Odd-numbered pages appear on the right, even-numbered pages on the left. 

o If front matter uses a different numbering scheme, that numbering is consistent and 

correct. 

o Elements such as prefaces, forewords, and chapters all begin on odd-numbered pages. 

 The file has been saved as a PDF. 

o The trim size (selected page dimensions) matches a trim size supported by Barnes & 

Noble Print Books on Demand. 

o Fonts are embedded in the PDF. 

o Encryption is turned off. 
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Creating a Cover 

A book’s cover is its first impression to intrigue readers, so it’s important to make sure that it 

accurately represents your book. The following includes helpful tips and instructions to ensure your 

cover turns out the way you want it to, while being a print-ready PDF. 

A Print-Ready PDF Cover 

Your book cover PDF is a separate file from your book layout PDF. The cover file consists of three 

elements (front, spine, back) that are created as separate files, but ultimately all laid out in a single PDF. 

The cover file is printed as a single sheet, and then wrapped around your book. 

 

 

Front Cover 

Every book cover is different, but almost all include the title and author’s name. It’s also common to see 

a subtitle, endorsement quote, or excerpt when applicable. Expressing the tone of your book can be 

achieved by using a typeface that reflects the mood of your book, or an image that represents the 

storyline. 
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Measurements 

If you choose not to use one of Barnes & Noble PBOD’s Templates, the measurements of your front 

cover should match the size of your book’s trim size, plus 0.125” - 0.13” of bleed room on all edges, 

except for the left edge, where your cover will connect with the spine. 

Using Microsoft Word  

Click the Page Layout tab and then choose Size to adjust the document size. You will most likely need 

to make this a custom size document. Under the Paper tab input your desired trim size. Click the 

Margins tab to add in your bleed room of 0.125” - 0.13” on all edges except for the left edge. Click OK.  

Then, without moving the typing cursor, click Insert in the menu bar, then click Photo or Picture  

Picture from File to insert your cover image. Click Save As a PDF or JPEG file.  

Layout and Images 

It’s important to remember that the bleed room might be cut off during printing, so be sure to keep 

your designs and items within the trim size measurements, keeping them out of the bleed room. Finally, 

double check to make sure any images used meet the same print resolution requirements as the 

manuscript. (See page 18 for more information about Images.) 

The Spine 

Similar to the front cover, the spine almost always includes the title and author’s name, as well as the 

publisher’s name when applicable. You can also extend your cover image onto the spine, or play with 

colors. Make sure the ultimate layout has the text read left to right when the book is cover-face-up. 

Measurements 

If you choose not to use one of Barnes & Noble PBOD’s Templates, you will have two spine trim size 

dimensions to consider. You’re going to create your spine horizontally to start, and then rotate it once 

it’s saved as a PDF.  First, set your spine document’s “width” to your book’s trim size height, plus 0.125” 

- 0.13” of bleed room on both sides. For example, if you’re creating a 6 x 9” book, then your spine 

document “width” would be 9.25.”  

Apply bleed room only to the left and right edges of your spine as it lays horizontally; do not apply it to 

the top and bottom since those edges will connect to the front and back covers once the spine is 

rotated.  

The measurement for your spine’s horizontal “height” depends on your book’s total page count—this 

means the total number of pages in your manuscript PDF, including front and back matter. It’s important 

not to mistake a page for a sheet. A sheet of paper means two pages (the front and back of the sheet of 

paper). 

 To calculate the width of the spine of your book using cream-colored paper, use the following 

formula:  # of pages ÷ 434 = spine width (in inches) for cream-colored paper 

For example, if your book with cream paper is 175 pages long, your spine width would be 0.403.” 
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 For a book printed on white-colored paper, use this formula instead:  # of pages ÷ 526 = spine 

width (in inches) for white-colored paper 

If your book with white paper is 175 pages long, your spine width would be 0.333.” 

 For a book printed on photo stock paper, use this formula:  # of pages ÷ 370 = spine width (in 

inches) for photo stock paper 

If your book with photo paper is 50 pages long, your spine width would be 0.135.” 

Using Microsoft Word on a PC:  

You will need to adjust the document layout so that you can create a custom page size as if the book is 

lying flat, cover-face-up. To create the spine, go to Page Layout and under Orientation, click on 

“Landscape.” Then go to Page Setup and choose Size to adjust the document size. Keep in mind that 

since your document is now in a Horizontal orientation, you must set “height” to your spine width and 

“width” to your spine height.  

Under Margins set the top and bottom margins to 0”, and remember to leave 0.125”- 0.13” of bleed 

room only for the left and right margins. Click OK. If you receive an error message from Word stating 

that your document height must be at least 1.0” click OK. You can change this in a later step.  Create 

your spine and Save first as a Word document and then as a PDF or JPEG by clicking File  Save As and 

choosing the preferred file type in the Format dropdown menu. Then click OK.  

To rotate your horizontal spine document into its vertical alignment, open the spine PDF document and 

choose View. Choose Rotate View and then Clockwise. Make sure to save your rotated file before 

closing.  

Using Microsoft Word on a Mac:  

You will need to adjust the layout of your spine document by creating a custom page size as if your 

book is lying flat, cover-face-up. To create the spine, go to the top navigation, click File then Page 

Setup… Under Paper size, choose Manage Custom Sizes… Keep in mind that since your document is 

now in a Horizontal orientation, you must set “height” to your spine’s final width and “width” to your 

book’s height.  

Under Margins set the top and bottom margins to 0,” and remember to leave 0.125”- 0.13” of bleed 

room for the left and right margins. Click OK. If you receive an error message from Word stating that 

your document height must be at least 1.0” click OK. You can change this in a later step.  Create your 

spine and Save first as a Word document and then as a PDF or JPEG by clicking File  Save As and 

choosing the preferred file type in the Format dropdown menu. Then click OK.  

To rotate your horizontal spine document into its vertical alignment, open the spine PDF document and 

choose View. Choose Rotate View and then Clockwise. Make sure to save your rotated file before 

closing.  
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Layout and Images 

For books with a page count of 50 pages or less, the spine is probably too small to include any text 

without it being cramped and hard to read. For books with a page count of 50-100, text will still be 

small, but will be legible if kept clean and simple. Remember to keep everything within the trim size 

height measurements, not going into the bleed room section, or too close to the sides.  

The Back Cover 

The back cover can include a variety of items, depending on your preference. Most include a book 

synopsis or endorsements, a brief about-line of the author (if not included inside the book), and a bar 

code or other pricing notes if applicable. You can also include your website, book specs and any other 

information you wish to share. 

Measurements 

The measurement of your back cover should match your book’s trim size, plus 0.125” - 0.13” of bleed 

room on all edges except for the right one, which will connect to the spine. 

Creating the back cover in Microsoft Word follows the same steps as creating the Front Cover. 

Layout and Images 

It’s important to remember that the bleed room might be cut off during printing, so be sure to keep 

your designs and items like your bar code within the trim size measurements, keeping them out of the 

bleed room. Finally, double check to make sure any images used meet the same print resolution 

requirements as the manuscript. (See page 18 for more information about images.) 

Assembling a Print-Ready Cover 

After creating your front cover, spine and back cover files, you will need to assemble them in a single 

PDF. We recommended using design software, like Adobe InDesign or Photoshop for doing this if 

possible. If you don’t own these programs you can also assemble your print-ready Cover file using 

Microsoft Word.  
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Using Microsoft Word to Assemble a Print-Ready Cover  

Make sure your front cover, spine and back cover are each saved as a PDF or JPEG file. Open a new 

Word document and resize it by clicking Page Setup or Page Layout. Update the paper size to the height 

and width of your overall cover file (see the formulas below) and click OK.  

 

Dotted lines represent the bleed and folds 

To calculate the overall bleed width of a Perfect Bound cover: 

0.125” (3 mm) bleed + back cover width + spine + front cover width + 0.125” (3 mm) bleed 

To calculate the overall bleed height of a Perfect Bound cover: 

0.125” (3 mm) top bleed + cover height + 0.125” (3 mm) bottom bleed 

Example: a 6” x 9” cover with a 0.5” spine would have a bleed size of 12.75” x 6.25” 

Note that this size might not be a default option, in which case you’ll need to create a custom size. 

Remember to set all of the margins of this new document to 0.0” since you have already 

accounted for bleed area in your separate PDF cover components.  Once you’ve resized your 

document, change the alignment from Left to Center, and click OK to apply the changes.  

Then, without moving the typing cursor, click Insert in the menu bar, then click Photo or Picture and 

then Picture from File. You’ll be prompted to choose a file to insert. Choose your back cover PDF or 

JPEG file first. After inserting your back cover PDF, click just to the right of the back cover before 

inserting your spine PDF. Do the same after you insert your spine PDF before you insert the front cover 

PDF.  
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If your spine width was less than 1.0” click on the spine after it’s been imported into the Word 

document, and under “Format Picture,” find the “Size” section. Uncheck the box so that you can edit 

the height and width of the spine document separately.  You can then adjust your spine’s width to the 

exact dimension you calculated earlier. This step works the same on Word for Mac or PC. Your three 

elements should now fit within your one cover document.  These steps will help ensure all three cover 

elements align correctly.  

The last step is to save your combined cover file as a PDF.  
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Appendix A. Instructions for Authors Using Pages for Mac or 

Pages for iOS 

Setting Page Sizes 

How to Set Page Sizes using Pages for Mac 

Go to File from the top navigation bar, then click on Page Setup from the drop-down menu. When the 

dialog box pops up, choose Manage Custom Size from the Paper Size section.  

When the second dialog box pops up, click on the + sign to add your new custom trim size. Type in 

your desired Width and Height in the Paper Size section and then click OK. Click OK again to set your 

new custom trim size for your book.  

 

 

Creating Page Breaks 

Go to Insert from the top navigation bar and then choose which type of break you want to insert e.g., 

Page Break.  
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The default page size is 8.5” x 11”, so you will need to adjust this to the actual dimensions of 

your document. 

 

Setting Up Running Headers and Footers 

In documents based on a Word Processing Template, running heads are the default until a Section Break 

is inserted. 

To view the header, hover the pointer at the top of the page until the Header box appears. In Pages, 

you see headers and footers by choosing View -> Show layer. To see them in Pages for iOS, tap the 

Tools icon (a wrench) and tap Document Setup. 

The Header is there. Hover the cursor over the top of the page until you see a Header box. Or, turn 

on Show Layout (View > Show Layout). 

In documents based on a Page Layout Template, you must turn on headers and footer explicitly. Hover 

near the top of the page or choose Show Layout to see the current settings for headers and footers. 
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Adjusting PDF Dimensions 

Embedding Fonts  

If you’re using Pages, you don’t have to worry about embedding fonts at this juncture. Once you save 

your document as a PDF, open the PDF in Preview, and then save it again. Your document is now saved 

with fonts embedded. It’s that easy. 

Saving a File as a PDF 

Open the File menu, select Save As…and choose PDF from the Format drop-down menu. Click Save.  

 

 


